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Printing
The SAS System under OS/2 takes advantage of the OS/2 printers. You can manage

your output in the same manner as you manage output from other OS/2 applications.
You can also take advantage of OS/2 fonts that are supported by your printers. For
details about using OS/2 printers, see your OS/2 documentation. “Producing Graphics”
on page 111 discusses how to route graphics from your SAS session to printers.
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Printing from within a SAS Window
To print the contents of one of the SAS windows, make that window active (by

clicking on it) and select

File I Print...

From the Print dialog box (shown in Display 5.1 on page 102), you can choose from
several actions:

� To print the contents of the currently selected window as text, click on OK .
� To print the contents of the currently selected window as a bitmap (that is, as a

picture of the window instead of as text), select the Print as Bitmap check box;
then click on OK .

� To print the contents of the currently selected window to a printer file (formatted
for the current printer), select the Print to File check box, type in the filename,
and then click on OK .

� To print the contents of the OS/2 clipboard, click on the Contents of: field. From
the displayed list box, select Clipboard (text) (or Clipboard (bitmap) if you
are printing it as a bitmap); then click on OK .

Note: The Print dialog box that is shown here might differ from what you see on
your system, depending on which version of OS/2 you use to run SAS and on the active
SAS window. 4

Display 5.1 The Print Dialog Box

The Print dialog box displays the destination printer’s name and the type of printer.
To change the destination printer, click on Setup... and select a new printer from the
Print Setup dialog box..

You can perform other printing tasks by combining these methods. For example, you
can print the contents of the currently selected window as a bitmap to a printer file by
selecting both the Print to File and Print as Bitmap check boxes.

Here is a summary of the choices that are related to SAS that the Print dialog box
offers:

Contents of:
displays the name of the window whose contents you want to print. You can
choose between the currently selected window and the OS/2 clipboard. If you
select Print as Bitmap, you can also choose to print a bitmap of the main SAS
window or a bitmap of the entire screen.
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Print to File
prints the selected window to a printer file in the correct format. For example, if
your currently selected printer is a PostScript printer, the resulting file will be in
PostScript format. The Print dialog box prompts you for a filename.

Note that you cannot edit the resulting printer file; it is in a format that is
readable only by the type of printer that is specified in the Print dialog box. If you
want to save the contents of an application window to a text file without printer
formatting, use the Save As... item in the File menu.

Print as Bitmap
prints the currently selected window as a bitmap instead of as text.

For more detailed information about the Print dialog box, click on the Help button.

Changing the Print Options
The Print Setup dialog box (shown in Display 5.2 on page 103) lets you control how

the SAS System prints information. For example, you use this dialog window to select
the page setup and the font that is used to print.

You can access this dialog box by selecting Print Setup... from the File menu, or
by clicking on Setup... from the Print dialog box. If you are using an application that
does not provide access to the menus, you can type DLGPRTSETUP at a command line.

Display 5.2 The Print Setup Dialog Box

The SAS System consults these sources for default printer settings (in order of
precedence, first to last):

� the setting of the SYSPRINT system option
� the system default printer (which you can select by adjusting the printer’s

properties in the OS/2 Printers folder).

Here is a summary of the information that is presented in the Print Setup dialog box:

Printer:
displays the name of the currently selected printer. To change the print job
settings, click on More .

Font
displays the current font. To change the font, click on Fonts... and then select a
new font, style, and size from the Font dialog box.

When you change the font size, the SAS System recalculates the maximum
LINESIZE and PAGESIZE values and displays them on the Print Setup dialog box.

Note: SAS tabular and columnar reports are formatted in a monospace font.
Using a proportionally spaced font might produce improperly formatted reports. 4
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Line Size and Page Size
display the maximum calculated line size and page size, respectively, for the
current printer and font settings. Although you cannot set these values directly
from this dialog, you can adjust them by changing the page setup, the font, and
the destination printer. Click on Page Setup... to access the Page Setup dialog box.
From there, you can change the margins and page orientation, which in turn affect
the line size and page size. The LINESIZE and PAGESIZE system options change
when you click on OK .

Also, the Print Setup dialog box contains a graphic that depicts the current
page orientation and margin settings.

Note: The margin settings affect printed output only. 4

Use Forms
specifies whether to use SAS System print forms, as described in “Using SAS
System Print Forms” on page 105.

To return to the default printer settings, click on Default .

Changing the Print Options Using the SAS System Options Window
To change the printer options using the SAS System Options window, you must know

the printer name, the font, and the line and page size that you want to use.
To change the printer settings by using the SAS System Options window, select

Tools I Options I System

You can then make the following changes to the printing system options:
� To change the printer:

� Select the Log and procedure output control folder and then select the
Procedure output folder.

� With the right mouse button, click on Sysprint and select Modify Value
from the pop-up menu.

� Type a printer name in the New Value text box and click on OK . Type the
printer name as it appears in the OS/2 printer properties. The printer name
is case-sensitive.

� To change the font:
� Select the Log and procedure output control folder and then select the

Procedure output folder.
� With the right mouse button, click on Sysprintfont and select Modify

Value from the pop-up menu.
� Type a font in the New Value text box and click on OK .

For valid values, see “SYSPRINTFONT” on page 379.
� To change the line size and page size:

� Select the Log and procedure output control folder and then select the
Log and procedure output folder.

� With the right mouse button, click on Linesize or Pagesize and select
Modify Value from the pop-up menu.

� Type a line size or page size in the New Value text box and click on OK .

Changing the Page Setup Options
The Page Setup dialog box (shown in Display 5.3 on page 105) lets you set the

margins and orientation for your printed output.
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You can access this dialog box by
� typing DLGPAGESETUP in the command bar
� selecting

File I Page Setup

� clicking on Page Setup from the Print Setup dialog box.

You can also change the margins and orientation by using the LEFTMARGIN,
RIGHTMARGIN, TOPMARGIN, BOTTOMMARGIN, and ORIENTATION system
options from the SAS System Options window. To change these options

1 Select

Tools I Options I System... I Log and procedure output control

I ODS printing

2 Place the cursor over the appropriate system option, click the right mouse button,
and select Modify Value.

3 Type a new value and click on OK .

Display 5.3 Page Setup Dialog Box

Here is a summary of the information that is presented in the Page Setup dialog box:

Margins
displays the amount of space to leave blank from the top, bottom, left, and right
edges of the paper. To change the margins, click in the text box and type in the
margin size.

Orientation
lets you select either Portrait or Landscape. Portrait prints vertically, landscape
prints horizontally.

Using SAS System Print Forms
To use a form to print from the SAS System, select the Use Forms check box in the

Print Setup dialog box. When you print, the SAS System prints your output with the
current print form.
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To specify a print form as the current print form, use the FORMNAME command or
specify the FORMS option in your SAS configuration file or in the SAS System Options
window. To learn the name of the current form, issue the FORMNAME command with
no parameters.

Using the FORM Window

The FSFORM command opens the FORM window, in which you can define print
forms to use when you print SAS output. You can specify printers, page formats,
margins, fonts, and printer control language in a FORM entry.

To invoke the FORM window, issue the following command:

FSFORMcatalog-name.form-name

See the SAS System Help for more information about the FSFORM command.
While the majority of the frames in the FORM window are the same across all

operating environments, the first frame that you see after issuing the FSFORM
command is the Printer Selection frame, which lists the printers that you are able to
use under OS/2. Display 5.4 on page 106 shows the default information for this frame.
To move from one FORM window frame to the next, use the NEXTSCR and PREVSCR
commands. These commands are located under the Tools menu item.

Display 5.4 Printer Selection Frame

The information in the Printer Selection frame is also site-dependent, so the printer
list at your site will be different from the one shown in Display 5.4 on page 106.

The Printer Selection frame appears only when you create a new print form. After
you create a form, it is stored in your user profile catalog or in the catalog that was
specified with the FSFORM command (entry type FORM). The next time that you
modify this form, the Printer Selection frame is skipped. You cannot return to the
Printer Selection frame from the second FORM window frame.

Printing with SAS Commands
If you prefer typing commands to using menus, you can use the PRINT or SPRINT

command to print the contents of the active window. For more information about these
commands, see the SAS System Help.
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Sending DATA Step Output to a Printer
You may want to spool your DATA step output to a printer instead of to a file. Use

the FILENAME statement and the PRINTER device-type keyword to accomplish this,
as in the following example:

filename myfile printer;
data _null_;

set mydata;
file myfile;
where city=’Cincinnati’;
put _all_;

run;

In this example, the PRINTER device-type keyword specifies to print the output to
the printer that is specified in the SYSPRINT system option. For more information
about the SYSPRINT system option, see “SYSPRINT” on page 379.

Sending Printed Output to a File
You can send your printed output to a file by clicking the Print to File check box

in the Print dialog box, and then specifying the name of a file to print to. This is not the
same as a save operation; the resulting printer file contains all the printer control
language that is necessary to support whatever options you have chosen with the
Printer Setup dialog box, such as fonts and page orientation. In most cases, this printer
file is not readable with a text editor; it is meant only to be sent to the printer.

You can also route printed output to a file by using the FILENAME statement, which
is useful for routing DATA step output. Here is an example:

filename myfile printer altdest=’c:\sas\results.dat’;
data _null_;

set qtr1data;
file myfile;
where sales ge 1000;
put _all_;

run;

In this example, the output from the DATA step is routed to a file, yet still contains
all the printer control information that is necessary for you to use your printer to
produce formatted output.

Another method of sending printed output to a file is to select the Output to file
check box in your printer’s Properties notebook Output Port page. When you send
output to a file, the contents of the file are overwritten if the file already exists. See
your OS/2 documentation for more information about changing printer properties.

Printing in Batch Mode
When you run SAS jobs in batch mode, you do not have access to the Print and

Printer Setup dialog boxes, but you can still take advantage of the OS/2 printer. Use
the SYSPRINT system option to specify your default printer (and the SYSPRINTFONT
system option to specify your printer font, if you want) as described on “SYSPRINT” on
page 379. For example, suppose your SAS configuration file contains the following
option:

-sysprint "f2hp5"
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Then, your SAS program might contain the following statements:

filename myfile printer;
data _null_;

set schools;
file myfile;
where enrolled le 500;
put _all_;

run;

When you submit your job, the SAS System uses the SYSPRINT printer specification
to spool your output from the DATA step to the OS/2 printer.

Default Printer Details
The SAS System looks for a default printer as follows (in order of precedence, first to

last):
� the SYSPRINT system option value
� the OS/2 system default printer.

The SYSPRINT system option is defined as the OS/2 default printer during SAS
installation.

To see the value of the SYSPRINT system, open the Print Setup dialog box by either
� selecting

File I Print Setup

� typing DLGPRTSETUP in the command bar.

To change the SYSPRINT system option, see “Changing the Print Options” on page
103.

Routing Procedure Output to a Web Browser
Beginning with Version 7 of SAS, the Output Delivery System can create your

procedure output in HTML to be viewed in a Web browser. The procedure output
HTML file is displayed in the Web browser that is specified in the Preferences dialog
box Web page. When you specify to display procedure output in HTML, you switch to
another application to view the HTML output.

For more information about using HTML within the Output Delivery System, see
The Complete Guide to the SAS Output Delivery System.

Configuring Preferences for HTML Output
For SAS to create an HTML file from your procedure output and to know where to

display the HTML file, you configure the Results and Web pages of the Preferences
dialog box.

To open the Preferences dialog box, select

Tools I Options I Preferences...

To configure the Results page:
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Click on the Results page.
Select the HTML check box.
Click in the Style check box and highlight a style. The style defines colors and fonts

to display your output.
Select where to save your HTML file. To save HTML files only while the current SAS

session is active, select the Use WORK folder check box. Saving HTML files to a
temporary folder is useful when you are testing a procedure and creating a
multitude of HTML files. Recall that when you exit the SAS System, all temporary
files are deleted.

To save the HTML files in a folder that is not deleted when a SAS session ends,
type a path name in the Folder text box or click on Browse to select a folder.

To configure the Web page of the Preferences dialog box:
� Click on the Web page.
� In the Preferred Browser text box, type the browser’s path and filename or click

on Browse to find the browser filename.

For more information about using HTML within the Output Delivery System, see
SAS Procedures Guide.

Routing Procedure Output and the SAS Log to a File
This section provides examples of the most common methods of routing SAS

procedure output and the SAS log to a file. Generally, this task is the same across
operating environments and is discussed in the SAS System Help. However, the
specification of external filenames and devices is system dependent. See “Referencing
External Files” on page 82 for complete information about the various ways to reference
external files.

You can route your SAS procedure output or the SAS log to a file in one of several
ways. The method that you choose depends on the method that you use to run the SAS
System, the moment at which you make your decision to route the output or SAS log,
and your personal preference.

Some methods of sending SAS procedure output or the SAS log to a file include using
� the Save As dialog box, invoked either from the File menu, the pop-up menu for

the window that you want to save, or by typing DLGSAVE in the command bar.
� the FILE command.
� the PRINTTO procedure.
� various system options, including PRINT and ALTLOG.

Using the Save As Dialog Box
The easiest way to save the contents of the active window to a file is to select

File I Save As

from the main SAS menu or pop-up menu, making sure that the active window (for
example, Log or Output) contains the output that you want to save. For more
information about the Save As dialog box, see “Opening and Saving Files” on page 29.

Using the PRINTTO Procedure
In batch SAS sessions, the SAS procedure output and the SAS log are written by

default to files named filename.LST and filename.LOG, respectively, where filename is
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the name of your SAS job. For example, if your SYSIN file is MYPROG.SAS, the
procedure output file is named MYPROG.LST, and the log file is named MYPROG.LOG.
However, you can override these default filenames and send your output and log to any
file that you choose. For example, suppose that your job contains the following
statements, which assign the fileref MYOUTPUT to the file C:\SAS\FIRST.TXT. Then
the PROC PRINTTO statement tells the SAS System to send any upcoming SAS
procedure output to the file that is associated with MYOUTPUT.

filename myoutput ’c:\sas\first.txt’;
proc printto print=myoutput;
run;

Any PROC or DATA statements that follow these statements and that generate
output send their output to the C:\SAS\FIRST.TXT file, not to the default procedure
output file. If you want to return to the default file, issue an empty PROC PRINTTO
statement like the following example:

proc printto;
run;

Issuing these statements redirects the SAS procedure output to the default
destination (filename.LST). In this way, you can send the output and log from different
parts of the same SAS job to different files.

Note: If you route procedure output to a file, the resulting file may contain carriage
control characters. To suppress these control characters when you include the file in the
Program Editor window, set the RECFM= option to P in the FILENAME statement. 4

If you want to send the SAS log to a specific file, use the LOG= option instead of the
PRINT=option in the PROC PRINTTO statement. For more information about the
PRINTTO procedure, see “PRINTTO” on page 283 and SAS Procedures Guide.

Note: When you use the PRINTTO procedure to route SAS procedure output or the
SAS log, the status window does not reflect any rerouting of batch output but indicates
that it is routing the procedure output file and log to filename.LST and filename.LOG. 4

Using SAS System Options
You can use SAS system options to route your SAS output or SAS log to a file. For

example, if you want to override the default behavior and send your procedure output
from a batch SAS job to the file C:\SAS\PROG1.TXT, you can invoke the SAS System
with the following command:

sas -sysin c:\sas\prog1
-print c:\sas\prog1.txt

This SAS command executes the SAS program PROG1.SAS and sends the procedure
output to the file C:\SAS\PROG1.TXT. You can treat the SAS Log similarly by using
the LOG system option instead of the PRINT system option. Two other related system
options, the ALTPRINT and ALTLOG options, are explained in “ALTPRINT” on page
325 and “ALTLOG” on page 324.

Note: The status window does reflect the PRINT and LOG system option values
when it records where the procedure output and log are being sent. 4
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Producing Graphics

See SAS/GRAPH Software: Reference for full details about using SAS/GRAPH
software. Also see “Overview of Graphics Considerations” on page 405 for further
details about using graphics and fonts with the SAS System under OS/2.

Producing Graphics on Your Display
In most cases, output is automatically displayed on your monitor when you run a

SAS/GRAPH procedure; it is not necessary to specify a SAS/GRAPH device driver.
Information about your graphics display is stored in an OS/2 information file and is
automatically used by the SAS System during an interactive SAS session.

Here is a simple example of how to produce a graphic:

data hat;
do x=-5 to 5 by .25;

do y=-5 to 5 by .25;
z=sin(sqrt(x*x+y*y));
output;

end;
end;

proc g3d data=hat;
plot y*x=z/ctop=red;
title ’Cowboy Hat with G3D’;

run;
quit;

Display 5.5 on page 111 shows the output for this program:

Display 5.5 Cowboy Hat Procedure Output

If you use the DEVICE= option in the GOPTIONS statement to route your graphics
to a hardcopy device, and then you want to return to using your monitor to display
graphics, you must specify a driver. Submit the following statement to display graphics
output on your monitor:

goptions device=win;
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You should also use the WIN device driver to produce graphics on your display when
you run your SAS job in batch mode.

If you specify that your program output is to be displayed in HTML, your graphic is
converted to a .GIF file and stored in the same folder as your SAS System data set. For
more information, see The Complete Guide to the SAS Output Delivery System.

Printing Graphics
You can use two methods to print output from SAS/GRAPH:
� Use a printer driver for your device (supplied with OS/2 or with your output

device). This method allows SAS/GRAPH to send generic graphics commands to
the OS/2 printer driver, which then translates the commands to a format that the
printer can use.

� Use a SAS/GRAPH printer driver to create a printer-specific graphics stream that
can be sent directly to the device. When you use a SAS/GRAPH printer driver, SAS
bypasses the OS/2 printer drivers and creates printer-ready output for your device.
The printer driver is also called a SAS/GRAPH native printer driver, which means
that the driver creates output by using the printer language that is native to the
target device, SAS/GRAPH printer drivers under OS/2 are similar to those that
are used by the SAS System under mainframe and UNIX operating environments.

After SAS prepares output for a printer (by using either OS/2 printer drivers or a
SAS/GRAPH printer driver), the output is sent to the OS/2 printer, which then queues
it for printing on the device of your choice. Figure 5.1 on page 112 illustrates how you
can use the two sets of printer drivers within SAS/GRAPH to produce output for a
given device.

Figure 5.1 SAS/GRAPH Generic Printer Drivers Compared with SAS/GRAPH Native
Printer Drivers

The method that you choose depends on the output device that you are using; see
“Choosing between a SAS/GRAPH Native Driver and the OS2Pxxx Driver” on page 114
for more information. You can control both graphics printing methods by using either
the Print and Print Setup dialog boxes or the SYSPRINT= option and the GOPTIONS
DEVICE= statement.

Using the SAS/GRAPH Generic (OS2Pxxx) Drivers
To print a graphic by using the SAS/GRAPH generic device drivers with the OS/2

printer drivers:



Managing SAS Output 4 Printing Graphics 113

1 Select Print Setup from the File menu and verify that the Printer field in the
Print Setup dialog box lists the correct OS/2 printer. You can use the Print Setup
dialog box to select any printer that you have installed on OS/2. (To install new
drivers and port combinations, use the WarpGuide, which you can access through
the Assistance Center folder.)

Alternatively, you can use the SYSPRINT system option to assign the
destination printer. For example,

options sysprint=’HP LaserJet III’;

Note that you may assign only printer driver names that have been previously
configured in OS/2.

2 Run your SAS/GRAPH program with the following graphics option:

GOPTIONS DEVICE=OS2Pxxx;

The value of OS2Pxxx you specify depends on the type of output device that you
use to print your graph:

OS2PRTM
for black and white (monochrome) printers

OS2PRTG
for grayscale printers

OS2PRTC
for color printers

OS2PLOT
for plotters.

The orientation of graphics output is determined by the following:

� If you specify the ROTATE= graphics option, the output is oriented according to
the value that you specify for ROTATE. For example, suppose you specify

goptions rotate=landscape;

Then the output is oriented as landscape, regardless of the settings in the Print
Setup dialog box.

� If you do not use the ROTATE= option, the output is oriented according to the
settings in the Page Setup dialog box.

Note: Graphics printing is affected by the margins that are specified in the Page
Setup dialog box. If you modify the margins when printing graphics and your intention
is to keep the graphics proportional, be sure the change the top and bottom margins by
the same amount that you change the left and right margins. 4

Using the SAS/GRAPH Native Printer Drivers
SAS/GRAPH native drivers are drivers that produce output in the native language

of the target device. Examples of SAS/GRAPH native drivers include

PS produces Postscript output.

HPLJS3 produces output in the PCL5 language that is used by
Hewlett-Packard LaserJet III printers.

HP7550 produces HPGL output that is used by Hewlett-Packard 7550
plotters.
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After the SAS/GRAPH native printer driver has produced output in the native
language of the target device, SAS then routes the output to the device that uses the
OS/2 printer. The SAS System bypasses the OS/2 driver that is currently associated
with the target device, but it does respect the destination that is specified in the Print
Setup dialog box when deciding where to send the output.

To print a graph by using a SAS/GRAPH printer driver, run your SAS/GRAPH
program with the following graphics options:

GOPTIONS DEVICE= driver-name;

where driver-name is the name of a valid SAS/GRAPH device driver. Consider this
example,

goptions device=hpljs2;

This statement formats the graph for the Hewlett-Packard LaserJet Series II printer.
You can view the complete list of SAS/GRAPH drivers by submitting the PROC
GDEVICE statement.

To print a graph to a printer file (also called a graphics stream file, or GSF) instead
of directly to a printer, use the GSFNAME option in the GOPTIONS statement and use
a filename or fileref to specify where you want the output. For example:

filename graphout "graphpic.prn";
goptions gsfname=graphout gsfmode=replace

device=hpljs2;

Printing and Previewing from the GRAPH Window
You can preview a graph that you create and, at the same time, format it for optimal

display on the device of your choice. To preview the graph before you print it, run your
SAS/GRAPH program with the following GOPTIONS statement:

GOPTIONS TARGETDEVICE= driver-name;

where driver-name is either one of the OS2Pxxx drivers or a SAS/GRAPH native driver.
By specifying a target device, SAS/GRAPH can format the graph with colors and

attributes that are appropriate for the target printer. To print the graph after it is
displayed, select Print from the File menu.

Note: If you do not specify a target device before you create the graph, SAS/GRAPH
will prompt you (in the Print dialog box) for a device driver name when you attempt to
print the graph that you are previewing. In most cases the OS2PRTM or OS2PRTC
driver is specified by default. The graph colors, orientation, and sizing might not be
optimal for the output device you specify, however. 4

Choosing between a SAS/GRAPH Native Driver and the OS2Pxxx Driver
When deciding whether to use SAS/GRAPH native drivers or the OS2Pxxx series of

drivers, consider such factors as the device that you are using and the type of output
that you want to produce. Note the following specific considerations:

� If no OS/2 printer driver is available for your device, use a SAS/GRAPH native
driver.

� If you have a device for which there is no SAS/GRAPH native driver, use the
OS2Pxxx driver, if an OS/2 printer driver is available for the device. In cases
where a new model of hardcopy device becomes available between releases of the
SAS System and the hardware vendor provides a new OS/2 driver that uses new
features of the device, you can use a OS2Pxxx driver to take advantage of those
features.
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� To use OS/2 specific fonts in your SAS/GRAPH output, use one of the OS2Pxxx
drivers and specify the font just as you would specify one of the installed hardware
fonts for your printer. See “Overview of Graphics Considerations” on page 405 for
more information about generating hardware fonts.

Importing Graphics from Other Applications
SAS/GRAPH lets you import bitmap and vector graphics that were created by other

software packages. This provides these benefits:

� You can create your graphic by using another graphics editor, then import the
graphic into SAS/GRAPH to produce output on a specialized device.

� You can merge clip art and graphs from other applications with the graphs that
you create in SAS/GRAPH.

You can import bitmap graphics into these SAS System windows:

� GRAPH window. The imported graphic becomes a new GRSEG entry in the
current catalog.

� Graphics Editor. The imported graphic becomes part of the current graph.

� Image Editor window. The imported graphic becomes a new image.

The SAS System provides two ways to import bitmap graphics into SAS/GRAPH:

� From the application that you used to create the graphic, copy the graphic to the
OS/2 clipboard; then switch to your SAS session and paste the graphic into the
SAS/GRAPH window, as described in “Pasting Graphics from the OS/2 Clipboard”
on page 115.

� From the SAS/GRAPH window (or the Graphics Editor or Image Editor) import
the graphics file by using the Import Image dialog box, as described in “Importing
a Graphics File from within a SAS/GRAPH Window” on page 115.

To import vector graphics, use the GIMPORT procedure to import computer
graphics metafile (CGM) files. The imported files are stored as GRSEG catalog
entries. This method preserves the individual graphic objects in the imported
graph, whereas the other methods treat the imported graphic as a single
(uneditable) bitmap. For more information about PROC GIMPORT, see SAS/
GRAPH Software: Reference.

Pasting Graphics from the OS/2 Clipboard
If the tool that you use to create the source graphics is an OS/2 application, then you

can use the OS/2 clipboard to copy the graphics to your SAS session as follows:

1 From the application that you used to create the graphic, select the graphic and
copy it to the clipboard. Use the copy procedures for your graphics tool.

2 Switch to your SAS session (or start your SAS session, if it is not already running).

3 With the SAS/GRAPH window active, select Paste from the Edit menu (or use the
GPASTE command). The graphic is pasted into the SAS/GRAPH window.

Importing a Graphics File from within a SAS/GRAPH Window
SAS/GRAPH provides import filters to translate graphics files that were created in

other applications to a format that you can use with the SAS System.
You can import graphics from other applications that produce files in any of the

formats that are shown in Table 5.1 on page 116.
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Table 5.1 Graphics Import File Formats

Graphics File Format File Extension

OS/2 bitmap BMP

OS/2 metafile MET

Device independent bitmap DIB

JPEG format JPG

graphic interchange format (GIF) GIF

tag image file format (TIFF) TIF

PC Paintbrush PCX

Truevision Targa TGA

Encapsulated PostScript Interchange (EPSI) PS

Portable Network Graphics PNG

Photo CD image PCD

Portable Pixmap PBM

X Window bitmap XBM

X Window dump XWD

To import bitmap graphics into SAS/GRAPH:

1 Make the GRAPH window active, and then select Import Image... from the
File menu.

2 Use the Import Image dialog box to select the source directory and graphics file.
Ensure that the Format field shows the correct source format; this indicates which
import filter SAS/GRAPH will use. You can have the SAS System automatically
detect the file format of the file to import by selecting AUTO as the Format. Click
on OK .

Note: Automatic file format detection through using AUTO does not detect the
DIB file format 4

You can also include IMAGE catalog entries in your graphs. For information about
including IMAGE catalog entries, see SAS/GRAPH Software: Reference.

Exporting Graphics for Use with Other Applications
The SAS System provides the following methods of exporting graphics that were

created in SAS/GRAPH for use with other word processing or desktop publishing
packages, or for display on the Internet or on an intranet:

� Export the graphics to a file from the GRAPH window, Graphics Editor, or Image
Editor, as described in “Exporting a Graphic to a File from a SAS/GRAPH
Window” on page 117.

� Copy the graphics (or a portion of them) to the OS/2 clipboard, then paste the
contents of the clipboard into the target application (as a bitmap or picture), as
described in “Pasting Graphics from SAS/GRAPH into other OS/2 Applications” on
page 117.
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� Create a computer graphics metafile (CGM) file for use with a specific graphics
package, using drivers that are included with the SAS System, as described in
“Creating CGM Files for Export to Other Applications” on page 118.

You can also use SAS/GRAPH to create GIF and VRML files for use with Web
browsers, PDF files for use with the Adobe Acrobat reader, and many other useful types
of graphics files. For more information about how to create these types of files, see
SAS/GRAPH Software: Reference and the online Help for SAS/GRAPH.

Exporting a Graphic to a File from a SAS/GRAPH Window
SAS/GRAPH provides export filters to translate graphics that were generated in

SAS/GRAPH into formats that you can use with other applications, such as spreadsheet
and desktop publishing programs.

You can export graphics from SAS/GRAPH in any of the formats that are shown in
Table 5.2 on page 117.

Table 5.2 Graphics Export File Formats

Graphics File Format File Extension

OS/2 bitmap BMP

OS/2 metafile MET

Device independent bitmap DIB

JPEG format JPG

graphic interchange format (GIF) GIF

tag image file format (TIFF) TIF

Adobe PostScript PS

Encapsulated PostScript Interchange (EPSI) PS

Portable Network Graphics PNG

Portable Pixmap PBM

To export a graph from the GRAPH window:
1 Make the GRAPH window active and then select Export Image... from the File

menu.
2 In the Export Image dialog box, select the target file format.
3 Specify the directory and filename for the exported graphic. Click on OK .

For more information about exporting graphics to a SAS IMAGE catalog entry from
the Image editor, see the online Help for SAS/GRAPH.

Pasting Graphics from SAS/GRAPH into other OS/2 Applications
A quick way to export graphics from the SAS System to another OS/2 application is

to use the OS/2 clipboard. When you copy information from SAS/GRAPH to the
clipboard, you can then paste that information into any application that accepts DIB or
BMP input.

To copy information from SAS/GRAPH to the clipboard:
1 From the GRAPH window, hold down the left mouse button and drag the mouse

over the portion of the graph that you want to copy. A selection box marks off the



118 Exporting Graphics for Use with Other Applications 4 Chapter 5

selected area as you move the mouse. When you are finished, release the mouse
button.

If you do not select an area of the graph to copy, the next step will copy the
entire graph to the clipboard.

2 With the GRAPH window still active, press CTRL+C (or select Copy to Paste
Buffer from the Edit menu).

This copies the graph to the clipboard. You can then return to the target application
and paste the graph (typically by using the Paste or Paste Special options in the
target OS/2 application). See the documentation for the target OS/2 application for
more information about how to paste information from the clipboard.

Creating CGM Files for Export to Other Applications
You can export graphs from SAS/GRAPH to other graphics packages by using

drivers that were developed specifically for those packages. When you use computer
graphics metafiles (CGMs) as the medium of transport between packages, your graph
retains its separate components so that you can independently edit and size it. The
editing capabilities you can use depend on the target graphics package.

To create a CGM from SAS/GRAPH, set GOPTIONS as follows:

FILENAME fileref ’filename.CGM’;

GOPTIONS DEVICE=CGMxxxx GSFNAME= fileref
GSFMODE=REPLACE;

where CGMxxxx is the appropriate CGM driver for your target application, and
filename.CGM is the name of the file that you want to create. Table 5.3 on page 118
lists the graphics packages to which you can export CGMs, the appropriate drivers to
use, and the SAS documents that describe how to export file and use them with the
target application. You access these documents from SAS Institute’s Technical Support
Division on the SAS Institute Web site.

The driver names that are marked with an asterisk (*) are already provided with
Version 8 of the SAS System. For each driver that is not provided, the corresponding
document describes how to build the driver.

Table 5.3 CGM Drivers and Documentation for Popular Graphics Packages

Package Suggested Driver Document

Aldus PageMaker CGMAPMA* TS-252F

Aldus Persuasion CGMAPSA* TS-252D

BPS 35 MM Express CGM35 TS-252

Borland Quattro Pro (Windows) CGMBQWC TS-252J

Borland Quattro Pro (DOS) CGMBQA* TS-252

CorelDRAW 5 CGMCOR5L TS-252R

Frame Tech FrameMaker CGMFRCA* CGMFRGA*
CGMFRMA* PSCFRAME
PSGFRAME PSMFRAME

TS-252H

Harvard Graphics 2.12 for DOS CGHHG TS-252

Harvard Graphics 3.0 for DOS CGMHG3A* TS-252A

Harvard Graphics for Windows CGMHGWA* TS-252C
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Package Suggested Driver Document

Harvard Graphics 3.0 for
Windows

CGMHG3L TS-252T

ImageBuilder CGMIMG TS-252

Interleaf 5 CGMCILFC* CGMGILFG*
CGMMILFM* PSILEAFC
PSILEAFG PSILEAFM

TS-252I

Lotus Ami Pro 3.0 CGMAM3C* CGMAM3G
CGMAM3M

TS-252M

Lotus Ami Pro 2.0 CGMAMIA TS-252

Lotus Freelance for DOS CGMFLALJ* CGMFLAPL*
CGMFLAPT*

TS-252

Lotus Freelance for Windows
2.0

CGMFL2C* CGMFL2G
CGMFL2M

TS-252K

Lotus Freelance for Windows
1.0

CGMFLWA* TS-252

Lotus 1-2-3 4.0 CGM123C* TS-252N

Lotus 1-2-3 CGM123 TS-252

Lotus Office 97 CGMLOT97 CGMLT97P TS-252Y

Microsoft Word for Windows 6.0 CGMMW6C* CGMMW6G
CGMMW6M

TS-252L

Microsoft Word for Windows 2.0 CGMMWWC* TS-252B

Microsoft PowerPoint CGMMPPA TS-252E

Microsoft Office 97 CGMOFF97 CGMOF97P TS-252X

Polaroid CI3000 CI3000 TS-252

WordPerfect 5.1 for DOS CGMWPCA CGMWPCAP*
CGMWPGA CGMWPGAP*
CGMWPMA CGMWPMAP*

TS-252G

WordPerfect 5.2 for Windows CGMWPWA* TS-252

WordPerfect 6.0 for Windows
(Beta)

CGMWP6C CGMWP6G
CGMWP6M

TS-252O

WordPerfect 6.0A for Windows CGMWPGCA TS-252P

WordPerfect 6.1 Windows CGMWPGIL TS-252S

WordPerfect 6.0 for UNIX CGMWPUXL TS-252U

WordPerfect Presents for DOS CGMWPCA* CGMWPGA*
CGMWPMA*

TS-252G

Zenographics Pixie CGMPIX TS-252
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